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保証 2

当社では、本製品において、出荷の日から 1 年間、材料およびその仕上がりについて欠陥がないことを保証します。
この保証期間中に製品に欠陥があることが判明した場合、当社では、当社の裁量に基づき、部品および作業の費
用を請求せずに当該欠陥製品を修理するか、あるいは当該欠陥製品の交換品を提供します。保証時に当社が使用
する部品、モジュール、および交換する製品は、新しいパフォーマンスに適応するために、新品の場合、または再生
品の場合もあります。交換したすべての部品、モジュール、および製品は当社で保有されます。

本保証に基づきサービスをお受けいただくため、お客様には、本保証期間の満了前に当該欠陥を当社に通知して
いただき、サービス実施のための適切な措置を講じていただきます。お客様には、当該欠陥製品を梱包していただ
き、送料前払いにて当社指定のサービス・センターに送付していただきます。本製品がお客様に返送される場合に
おいて、返送先が当該サービス・センターの設置されている国内の場所であるときは、当社は、返送費用を負担し
ます。しかし、他の場所に返送される製品については、すべての送料、関税、税金その他の費用をお客様に負担し
ていただきます。

本保証は、不適切な使用または不適切もしくは不十分な保守および取り扱いにより生じたいかなる欠陥、故障または
損傷にも適用されません。当社は、以下の事項については、本保証に基づきサービスを提供する義務を負いません。
a）当社担当者以外の者による本製品のインストール、修理またはサービスの試行から生じた損傷に対する修理。b）不
適切な使用または互換性のない機器への接続から生じた損傷に対する修理。c）当社製ではないサプライ用品の使用
により生じた損傷または機能不全に対する修理。d）本製品が改造または他の製品と統合された場合において、改造
または統合の影響により当該本製品のサービスの時間または難度が増加したときの当該本製品に対するサービス。

この保証は、明示的または黙示的な他のあらゆる保証の代わりに、製品に関して当社がお客様に対して提供するも
のです。当社およびベンダは、商品性または特定目的に対する適合性についての一切の黙示保証を否認します。
欠陥製品を修理または交換する当社の責任は、本保証の不履行についてお客様に提供される唯一の排他的な法
的救済となります。間接損害、特別損害、付随的損害または派生損害については、当社およびそのベンダは、損害
の実現性を事前に通知されていたか否に拘わらず、一切の責任を負いません。
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安全にご使用いただくために

安全にご使用いただくために

人体への損傷を避け、本製品や本製品に接続されている製品への損傷を防止するために、次の安全性に
関する注意をよくお読みください。

安全にご使用いただくために、本製品の指示に従ってください。

資格のあるサービス担当者以外は、保守点検手順を実行しないでください。

本製品をご使用の際に、規模の大きなシステムの他の製品にアクセスしなければならない場合があります。
システムの操作に関する警告や注意事項については、他製品のコンポーネントのマニュアルにある安全に
関するセクションをお読みください。

火災や人体への損傷を避けるには

適切な電源コードを使用してください。 本製品用に指定され、使用される国で認定された電源コードの
みを使用してください。

本製品を接地してください。 本製品は、電源コードのグランド線を使用して接地します。 感電を避けるた
め、グランド線をアースに接続する必要があります。 本製品の入出力端子に接続する前に、製品が正しく接
地されていることを確認してください。

すべての端子の定格に従ってください。 火災や感電の危険を避けるために、本製品のすべての定格と
マーキングに従ってください。 本製品に電源を接続する前に、定格の詳細について、製品マニュアルを参
照してください。

入力は、メイン、カテゴリ II、 III、および IV 回路に対しては、定格化されていません。

電源を切断してください。 電源コードにより、電源から製品を切断します。 電源コードをさえぎらないでく
ださい。このコードは常にユーザが操作可能であることが必要です。

カバーを外した状態で動作させないでください。 カバーやパネルを外した状態で本製品を動作させな
いでください。

障害の疑いがあるときは動作させないでください。 本製品に損傷の疑いがある場合、資格のあるサー
ビス担当者に検査してもらってください。

回路の露出を避けてください。 電源がオンのときに、露出した接続部分やコンポーネントに触れないで
ください。

バッテリの交換を正しく行ってください。 指定されたタイプおよび定格のバッテリと交換してください。

適切なヒューズを使用してください。 本製品用に指定されたタイプおよび定格のヒューズのみを使用し
てください。

湿気の多いところでは動作させないでください。

爆発しやすい環境では動作させないでください。

製品の表面を清潔で乾燥した状態に保ってください。

適切に通気してください。 適切な通気が得られるような製品の設置方法の詳細については、マニュアル
の設置方法を参照してください。
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安全にご使用いただくために

本マニュアル内の用語

本マニュアルでは、次の用語を使用します。

警告： 「警告」では、怪我や死亡の原因となる状態や行為を示します。

注意： 「注意」では、本製品やその他の資産に損害を与える状態や行為を示します。

本製品に関する記号と用語

本製品では、次の用語を使用します。

「危険」マークが表示されている場合、怪我をする危険が切迫していることを示します。

「警告」マークが表示されている場合、怪我をする可能性があることを示します。

「注意」マークが表示されている場合、本製品を含む資産に損害が生じる可能性があることを示します。

本製品では、次の記号を使用します。
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環境条件について

環境条件について

このセクションでは、製品の環境に対する影響について説明します。

製品の廃棄方法

機器またはコンポーネントをリサイクルする際には、次のガイドラインを順守してください。

機器のリサイクル：: この機器を生産する際には、天然資源が使用されています。この製品には、環境
または人体に有害な可能性がある物質が含まれているため、製品を廃棄する際には適切に処理する必要
があります。有害物質の放出を防ぎ、天然資源の使用を減らすため、部材を徹底的に再利用できるよう、本
製品のリサイクルにご協力ください。

下に示すシンボルは、この製品が WEEE Directive 2002/96/EC （廃棄電気・電子機器に関する指令）に基
づく EU の諸要件に準拠していることを示しています。リサイクル方法については、Tektronix ホームページ
（www.tektronix.com）のサポート／サービスの項目を参照してください。

水銀に関するお知らせ：: この製品に使用されている LCD バックライト・ランプには、水銀が含まれてい
ます。廃棄にあたっては、環境への配慮が必要です。廃棄およびリサイクルに関しては、お住まいの地域の
役所等にお尋ねください。

有害物質に関する規制

この製品は Monitoring and Control（監視および制御）装置に分類され、2002/95/EC RoHS Directive（電気・
電子機器含有特定危険物質使用制限指令）の範囲外です。この製品には、鉛、カドミウム、水銀、および
六価クロムが含まれています。
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まえがき

まえがき

このマニュアルでは、RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザの設置と基本的な操作につ
いて説明します。詳細については、機器のオンライン・ヘルプを参照してください。

主な機能
RSA6100A シリーズは、高性能のリアルタイム・スペクトラム・アナライザ・ファミリです。主な機能は次の通り
です。

周波数領域の変化をトリガとし（当社独自の周波数マスク・トリガを使用）、トランゼント RF 信号をイベント
ベースで取り込める

デジタル・フォスファ・スペクトラム解析により、障害発生の認識と特定にかかる時間を短縮できる

最大 110 MHz のスパンで信号をシームレスに取り込める

時間と共に変化する RF 信号が、マルチドメイン表示で一目で理解できる

他の信号アナライザでは取り込みが困難または不可能な信号の不安定性とトランゼントも表示される

検索機能により、スペクトラム・トレースとユーザ定義のリミット・ラインおよびマスクを比較し、合否を判定
する
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まえがき

マニュアル
当社の RSA6100A シリーズ・スペクトラム・アナライザには、次のマニュアルが用意されています。最新のマ
ニュアルについては、Tektronix ホームページを参照してください。

参照する項目 使用するマニュアル

設置と操作（概要） 『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・ク
イック・スタート・ユーザ・マニュアル』。 このマニュアルには、機
器を動作させる方法、ユーザ・インタフェース・コントロールのガイ
ド、および使用例に関する一般的な情報が記載されています。

操作とユーザ・インタフェースに関する
詳細なヘルプ

『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・オン
ライン・ヘルプ』。このオンライン・ヘルプでは、機器の操作方法
について詳しく説明しています。

プログラミング・コマンド 『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・プロ
グラマ・マニュアル』。 RSA6100A シリーズのプログラミング・コマ
ンドは、RSA6100A のハードディスクと製品ソフトウェア CD　に収
録されている PDF ファイルに記載されています。

仕様と性能検査 『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・テク
ニカル・リファレンス・マニュアル』。このマニュアルでは、機器の
仕様および保証特性に対する機器性能チェックの手順を説明し
ます。このマニュアルは、RSA6100A のハードディスクおよび製品
ソフトウェア CD に収録されている PDF ファイルです。

ユーザ・サービス 『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・サー
ビス・マニュアル』。交換部品リスト、注意および保守情報、モ
ジュール・レベルの修理情報が記載されたマニュアル（オプショ
ン）。

ソフトウェアのアップグレード
ソフトウェアのアップグレードを入手できます。スペクトラム・アナライザ・モデルとシリアル番号に合った正し
いオプション・キーを入力した場合にのみ、ソフトウェアのアップグレードが適用されます。

新しいアップグレードの有無を確認するには、次の手順に従います。

1. Tektronix ホームページ（www.tektronix.com）にアクセスします。

2. Software and Drivers を選択して、Software and Firmware Finder Web ページに移動します。

3. 製品名（RSA6100A）を入力し、入手可能なソフトウェアのアップグレードを検索します。
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このマニュアルの表記規則
このマニュアルで使用するアイコンの意味は、次のとおりです。

操作手順の
番号

電 源 オ ン
（フロント･パ
ネル）

電源コード
接続

ネットワーク
接続

PS2 接続 SVGA 接続 USB 接続
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設置

設置の前に
機器を開梱し、スタンダード・アクセサリとして記載されている品目がすべて揃っていることを確認します。ま
た、オプショナル・アクセサリおよび機器オプションもこのセクションに記載されています。最新の情報につい
ては、Tektronix ホームページ（www.tektronix.com）を参照してください。

スタンダード・アクセサリ
機器には、クイック･スタート･ユーザ･マニュアル（対応言語は以下に記載）、プログラマ･マニュアル（CD）、
テクニカル・リファレンス・マニュアル（CD）、サービス･マニュアル（CD）、電源コード、BNC-N アダプタ、USB
キーボード、USB マウス、キャリング・ケースなどのアクセサリが付属しています。

マニュアル

『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・クイック・スタート・ユーザ・マニュアル』は、
次の言語版があります。

英語、当社部品番号 071-1909-XX

簡体字中国語、当社部品番号 071-1910-XX

日本語、当社部品番号 071-1911-XX

ロシア語、当社部品番号 071-1912-XX

『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・ドキュメント CD』、当社部品番号 063-
3930-XX。ドキュメント CD には、次のマニュアルの PDF 版が収録されています。

『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・クイック・スタート・ユーザ・マニュアル』
（英語、日本語、ロシア語、簡体字中国語）

『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・プログラマ・マニュアル』、当社部品番
号 071-1913-XX

『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・サービス・マニュアル』、当社部品番号
071-1914-XX

『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・テクニカル・リファレンス・マニュアル』、
当社部品番号 071-1915-XX

『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・デクラシフィケーション／セキュリティ・イ
ンストラクション』、当社部品番号 071-2056-XX

電源コード

RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザには、各地域専用の電源コードが 1 本同梱され
ています。北米用の電源コードは安全性確認済みで CSA 認可済みのものです。北米以外の地域用のコー
ドは、当該国の機関（1 つ以上）により承認されているものです。
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各国の電源プラグ

Opt.A0 – 北米仕様電源

Opt.A1 – ユニバーサル欧州仕様電源

Opt.A2 – 英国仕様電源

Opt.A3 – オーストラリア仕様電源

Opt.A4 – 240 V 北米仕様電源

Opt.A5 – スイス仕様電源

Opt.A6 – 日本仕様電源

Opt.A10 – 中国仕様電源

Opt.A11 – インド仕様電源

Opt.A99 – 電源コードなし

オプショナル・アクセサリ
『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・サービス・マニュアル』、当社部品番号
071-1914-XX

RSA61RHD 型 - オプション 06 型で提供される増設リムーバブル・ハード・ディスク・ドライブ

065-0765-XX 型 - オプション 08 型で提供される増設リムーバブル・ソリッドステート・ハード・ドライブ
（Windows XP および機器ソフトウェアがプレインストール）

オプション
スペクトラム・アナライザには、次のオプションを追加できます。

オプション 01 型 - 10 MHz ～ 3 GHz のプリアンプの追加

オプション 02 型 - 周波数マスク・トリガおよび RAM 拡張の追加

オプション 05 型 - デジタル IQ 出力および 500 MHz のアナログ IF 出力の追加

オプション 06 型 - リムーバブル・ハード・ディスク・ドライブの追加（オプション 07 型またはオプション 08
型との同時指定は不可）

オプション 07 型 - DVD±RW ドライブの追加、無料オプション（オプション 06 型またはオプション 08 型
との同時指定は不可）

オプション 08 型 - リムーバブル・ソリッドステート・ハード・ドライブの追加（オプション 06 型または 07 型
との同時指定は不可）

オプション 11 型 - 位相ノイズおよびジッタ測定の追加

オプション 20 型 - 拡張測定解析機能（パルス測定を含む）の追加

オプション 21 型 - 汎用デジタル変調解析の追加

オプション 110 型 - 110 MHz のリアルタイム取り込み帯域幅の追加

オプション 1R 型 - ラックマウント・キットの追加
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動作条件

電源要件

電源電圧と周波数 消費電力

100 V ～ 240 VRMS、50/60 Hz

115 VRMS、400 Hz

600 W（最大）

環境要件

特性 説明

動作時温度 +5 ℃ ～ + 50 ℃
（+5 ℃ ～ +40 ℃、DVD ドライブまたはオプション
のリムーバブル・ハード・ディスク・ドライブにアクセ
スする場合）

温度（非動作時） -20 ℃ ～ +60 ℃

湿度 90%（30 ℃、結露なし）
最大 80%（DVD ドライブへのアクセス時）
最高湿球温度 29 ℃

使用可能高度：

動作時

非動作時

3,000 m（9,843 フィート）以下

12,190 m （40,000 フィート）

冷却用スペース

底部

側面と後部

20 mm （0.79 インチ）

50 mm （1.97 インチ）

注意： 正しく冷却するために、機器を横にして操作しないでください。機器がケース底面の脚で支えられて
いる状態でのみ、機器を操作できます。通気口周辺には、少なくとも 2 インチ（5 cm）のスペースを確保して
ください。

警告： 人的傷害を避けるために、スペクトラム・アナライザを持ち上げたり、移動したりする際は十分に注意
してください。機器は比較的重量があるので、移動の際は細心の注意が必要です。
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機器への接続

ネットワークへの接続

機器の電源を入れる前に、キーボード、マウス、プリンタ、その他のアクセサリを接続します（USB 対応アク
セサリは、電源投入の前後どちらでも接続できます）。

機器をネットワークに接続すると、プリ
ンタ出力、ファイル共有、インターネッ
ト・アクセスなどの通信機能を利用でき
ます。ネットワークに接続する機器の設
定については、ネットワーク管理者に問
い合わせ、標準の Windows ユーティリ
ティを使用してください。

ヒント

機器をネットワークに接続する場合、インターネット・ファイアウォールの使用、承認済み OS 更新の定期
的なインストール、最新のアンチウィルス・ソフトウェアの使用を通じて、機器の保護に努めてください。

機器の電源をオンにする
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機器の電源をオフにする

電源コードの取り外し

外部モニタの追加
デュアル・モニタ構成に外部モニタを追加するには、次の手順に従ってください。スペクトラム・アナライザと
外部モニタの両方で、カラーを True Color に設定する必要があります。
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1. スペクトラム・アナライザと外部モニ
タの電源をオフにします。

2. 外部モニタをスペクトラム・アナライ
ザに接続します。

3. スペクトラム・アナライザと外部モニ
タの電源をオンにします。
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4. Windows の Control Panel を開きま
す。

5. Intel(R) Extreme Graphics 2 M をダ
ブルクリックして、プロパティ・ペー
ジを開きます。

6. Intel(R) Dual-display Clone をクリッ
クし、内部スクリーン（Notebook）の
内容が外部モニタ（Monitor）に表示
されるようにします。
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7. 必要に応じて設定を調整し、OK を
クリックすると、設定が適用され、プ
ロパティ・ページが閉じます。

Windows の表示設定の調整

機器の表示設定を変更するには、デフォルトの Windows 表示プロパティではなく、Intel のグラフィック・ドラ
イバを使用します。Intel グラフィック・ドライバを使用すると、Windows の表示プロパティ・ダイアログ・ボックス
ではアクセスできない項目まで調節することができます。
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1. Windows の Control Panel を開きま
す。

2. Intel(R) Extreme Graphics 2 M をダ
ブルクリックして、プロパティ・ペー
ジを開きます。

3. 必要に応じて、設定を調整します。

注： 外部モニタが機器に接続されてい
ない場合は、プロパティ・ページの項目
をすべて使用できるとは限りません。

4. OKをクリックして設定を適用し、プ
ロパティ・ページを閉じます。

注： 推奨はできませんが、スペクトラム・アナライザの電源をオンにした後で外部モニタを接続することもで
きます。ただし、接続後、Intel Extreme Graphics 2M のコントロール・パネルで Extended Desktop を有効に
しなければなりません。
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機器の検査
機器には、診断アプリケーションが用意されています（Tools > Diagnostics）。機器の使用中に異常が発生し
た場合は、次の手順に従って、障害の詳細情報を収集してください。この手順は、詳細な受入検査として機
器の機能を確認する場合にも使用できます。機器の確度に関する仕様をチェックする場合は、ドキュメント
CD に収録されている PDF ファイル『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・テクニカル・
リファレンス・マニュアル』（部品番号 071–1915–00）を参照してください。

1. Tools > Diagnostics を選択し
ます。

2. Diagnostics タブで、All Mod-
ules, All Tests を選択します。

3. Single Test をクリックします。

4. Run をクリックします。

機器の診断テストは、一度に 1
つずつ実行されます。テストが
完了すると、各チェック・ボック
スの右にチェック・マークまた
は X マークが表示されます。
チェック・マークはテストにパ
スしたことを、X マークはテス
トに失敗したことを示します。

5. 診断テストの中には、マニュア
ル操作を必要とするものもあ
ります。そのようなテストでは、
画面の指示に従ってテストを
進めてください。

注： Diagnostics Failure Information タブでは、基本的な診断エラー情報を参照できます。障害の履歴と、
アプリケーションによって報告されるエラー情報（診断の結果以外の情報）については、Windows の Event
Viewer（Windows の Control Panel の Administrative tools のサブセット）で参照してください。
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ユーザ保守

機器のクリーニング

シャーシの外部表面のクリーニングには、乾いた柔らかい布か柔らかい毛ブラシを使用してください。汚れ
が落ちない場合は、75% のイソプロピル・アルコール溶液をしみ込ませた布または綿棒を使用してください。
コントロールやコネクタの周りの狭い部分のクリーニングには、綿棒を使用してください。機器を損傷する恐
れがあるため、どの部分にも研磨剤を使用しないでください。

注意： 外部のクリーニング時に機器の内部が湿らないように、溶液の量は布または綿棒が湿る程度に抑え
てください。フロント・パネルの On/Standby スイッチを水拭きしないでください。機器を水拭きする場合は、
スイッチを覆ってください。クリーニング時には、純水または蒸留水だけを使用してください。洗浄剤として
75% のイソプロピル・アルコール溶液を使用し、純水または蒸留水で洗い流してください。化学薬品の洗浄
剤を使用しないでください。シャーシを損傷する恐れがあります。ベンゼン、トルエン、キシレン、アセトンま
たはこれに類似する溶剤を含有する化学薬品を使用しないでください。

注意： フラットパネル・ディスプレイが損傷する恐れがあるため、不適切な洗浄剤やクリーニング方法は使
用しないでください。ディスプレイの表面のクリーニングに、研磨剤または市販のガラス用洗剤を使用しない
でください。液体をディスプレイの表面に直接吹き付けないでください。ディスプレイを磨くときは、力を入れ
すぎないでください。

ディスプレイの表面をクリーニングする場合は、ディスプレイをクリーニング用ティッシュで優しく拭いてくださ
い。ディスプレイの汚れがひどい場合は、蒸留水または 75% のイソプロピル・アルコール溶液でティッシュを
湿らせ、ディスプレイの表面を優しく拭きます。力を入れすぎないように注意してください。ディスプレイの表
面を傷つける恐れがあります。

機器のソフトウェアのアップグレード

ソフトウェアのアップグレードは当社から入手できます。Tektronix ホームページからダウンロードするか、当
社営業所に注文してください。ソフトウェアのオプションまたは機能を追加するには、当社が発行するオプ
ション・キーが必要です。当社からソフトウェアを入手したら、これを機器にインストールします。メッセージが
表示されたら、オプション・キーを入力し、画面の指示に従ってアップグレードを完了してください。

機器の返送

機器を当社に返送される場合：

ハード・ディスク上のソフトウェアをバックアップしてください。機器が戻ってきたら、ソフトウェアを再イン
ストールする必要があります。

機器を輸送用に再梱包する場合は、元の梱包資材を使用してください。元の梱包資材が手元にない
か、使用に適していない場合は、当社営業所まで新しい梱包資材をご依頼ください。

輸送用カートンを業務用ステープルまたは丈夫なテープで止めます。
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オペレーティング・システム修復 CD の作成
本機器には、オペレーティング･システム修復ディスクは付属していません。 機器を当社まで返送しなくても
搭載されているオペレーティング･システムを修復できるよう、運用開始前にオペレーティング･システム修
復ディスクを作成しておくことをお勧めします。 一連の修復ディスクの作成方法については、『RSA6100A シ
リーズ･リアルタイム・スペクトラム・アナライザ・サービス・マニュアル』の「オペレーティング･システムの修復」
セクションを参照してください。 この製品サービス・マニュアルは、製品ドキュメンテーション CD（当社部品
番号 063-3930-XX）に収録されています。また、当社のサイト（www.tektronix.com/manuals）からダウンロー
ドすることもできます。
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操作

機器の概要
コントロールとディスプレイの構成を次の図と表で示します。

フロント・パネル・コントロール

ほとんどのフロント・パネル・コントロールは、コントロール・パネルを開くためのショートカットです。

番号 アイテム 説明 同等のメニュー操作

1 メディア DVD±RW ドライブ、リムーバブル・ハード・ディ
スク・ドライブ、またはリムーバブル・ソリッドス
テート・ハード・ドライブ

2 Displays Displays ダイアログ・ボックスを開いて、測定表
示を選択します。

Setup > Displays

3 Settings 選択した表示の Settings コントロール・パネル
を開きます。

Setup > Settings

4 Trigger Trigger コントロール・パネルを開きます。 Setup > Trigger

5 Acquire Acquire コントロール・パネルを開きます。 Setup > Acquire

6 Analysis Analysis コントロール・パネルを開きます。 Setup > Analysis

7 Freq 測定周波数を調整します。 Setup > Analysis >
Frequency タブ 2

8 Span （ Spec-
trum）

Spectrum 表示に示されるスパン（周波数の範
囲）を調整します。 1

Setup > Settings >
Freq & Span 1 2
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番号 アイテム 説明 同等のメニュー操作

9 Amplitude 基準レベルを調整します。 Setup > Amplitude 2

10 BW（Spectrum） 分解能帯域幅（RBW）を調整します。 1 Setup > Settings >
BW タブ 1 2

1 選択した表示が Spectrum、DPX Spectrum、または Spectrogram の場合にのみ適用されます。
2 1 秒間押したままにし、関連するコントロール・パネルを表示します。

番号 アイテム 説明 同等のメニュー操作

11 Tab ダイアログ・ボックスまたはコントロール・パネル
で、カーソルを次のエントリに移動します。外
部キーボードで、Tab キーを押す操作と同じで
す。

12 Run（Stop） アクイジションを開始または停止します。 Run > Run

13 Markers, Peak アクティブなマーカを、選択した表示の最大
ピークのトレースに移動します。マーカがオフに
なると、MR（マーカの基準）マーカが最大ピー
クに表示されます。

14 Markers, Select 次のマーカを選択します。

15 Markers, Define Markers コントロール・パネルを開きます。

16 Esc 変更を保存せずにダイアログ・ボックスを終了
します。
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番号 アイテム 説明 同等のメニュー操作

17 コントロール・ノ
ブ

数値コントロールおよびリスト・コントロールの値
を変更します。ノブを押す（ノブをクリックする）
ことは、キーボードで Enter キーを押す操作と
同じです。

18 矢印キー マーカを移動します。上矢印キーを押すと、選
択したマーカを 10 トレース・ポイント右に移動
します。下矢印キーを押すと、選択したマーカ
を 10 トレース・ポイント左に移動します。左右の
矢印キーを押すと、選択したマーカを次のピー
クに移動します。（ノブを回すと、マーカを 1 ト
レース・ポイント右または左に移動します。
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番号 アイテム 説明 同等のメニュー操作

19 キーパッド コントロールの値を入力します。

20 Enter コントロールのデータ・エントリを完了します。
キーボードで、Enter キーを押す操作と同じで
す。

番号 アイテム 説明 同等のメニュー操作

21 Recall Recall ダイアログ・ボックスを開きます。 File > Recall...

22 Save 前の Save 操作と同じ選択内容を使用して作業
ファイルを保存します。

File > Save

23 Touch Screen
On/Off

タッチ・スクリーンのオン／オフを切り替えます。

24 Help オンライン・ヘルプを表示します。 Help > User Manual

25 Print Print ダイアログ・ボックスを開きます。RSA6100A
アプリケーション・ウィンドウの画面取り込みを
出力します。

File > Print

26 Preset 機器をデフォルト値またはプリセット値に戻しま
す。Preset を操作すると、スペクトラム・アナラ
イザ表示ウィンドウのみが開いた状態になりま
す。

Setup > Preset
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フロント・パネル・コネクタ

番号 アイテム 説明

1 Trig Out トリガ出力コネクタ。50 Ω、BNC、 ハイ > 2.0 V、ロー < 0.4 V、（出力電流
1 mA）

2 Trig In 外部トリガ入力コネクタ、–2.5 V ～ +2.5 V、（トリガレベルはユーザ設定可）

3 USB 1.1 USB 1.1 マウス・コネクタ

4 USB 2.0 USB 2.0 コネクタ

5 RF Input RF 入力コネクタ 50 Ω
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リア・パネル

番号 コネクタ、説明

1 AC 入力、 主電源コネクタ

2 GPIB

3 IF 出力（オプション 05 型）

4, 5 リアルタイム IQ 出力（オプション 05 型）

6 Ref In、基準周波数の入力

7 Ref Out、基準周波数の出力

8 ヘッドフォン、オーディオ出力コネクタ。

9 外部トリガ 2 入力

10 周辺機器接続用 COM 2、シリアル・ポート

11 VGA、外部モニタ出力（解像度は VGA に制限されません）

12 PS2 キーボード入力

13 マウスやその他 USB2 デバイス用 USB2 ポート

14 TekProbe®、予約

15 +28 VDC 出力、（切り替え可能）

16 LAN、イーサネット・ネットワーク・コネクタ

インタフェースと表示項目

通常使用するボタンやコントロールは、ツール・バー内にあります。ほとんどのボタンで、コントロール・パネ
ルを開き、機器のセットアップを変更することができます。コントロール・パネルの内容は、選択した表示によ
り異なります。フロント・パネルのボタンまたはキーボードからもコントロール・パネルにアクセスできます。
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番号 アイテム 説明

1 Displays Select Displays ダイアログ・ボックスを開くと、測定表示を選択で
きます。

2 Markers ウィンドウの下部の Marker ツール・バーを開いたり、閉じたりし
ます。

3 Settings 選択した表示の Settings コントロール・パネルを開きます。各表
示から、個別のコントロール・パネルにアクセスできます。

4 Trigger Trigger コントロール・パネルを開くと、トリガ設定を定義できます。

5 Acquire Acquire コントロール・パネルを開くと、アクイジション設定を定義
できます。

6 Analysis Analysis コントロール・パネルを開くと、周波数、解析時間、ユ
ニットなど解析の設定を定義できます。

7 Center Frequency 中心周波数を表示します。値を変更する場合は、テキストをク
リックし、フロント・パネルのノブで周波数を調整します。フロント・
パネルのキーパッドまたはフロント・パネルの上下ボタンを使用
しても、周波数を入力することができます。

8 Reference Level 基準レベルを表示します。値を変更する場合は、テキストをクリッ
クして、キーパッドから数字を入力するか、フロント・パネルの上
下ボタンを使用します。
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番号 アイテム 説明

9 Amplitude Amplitude コントロール・パネルを開いて、リファレンス・レベルを
定義したり、内部減衰を設定したり、（オプションの）プリアンプの
有効／無効を切り替えたりできます。

10 Replay 新しい設定を使用して、既存のアクイジション・データ・レコード
に新しい測定周期を実行します。

11 Run データのアクイジションを開始または停止します。機器がデータ
を取り込んでいるときは、ボタンのラベルの文字が緑で表示され
ます。停止すると、ラベルの文字は黒で表示されます。

Run メニューで、実行条件を指定できます。たとえば、Run メ
ニューの Single Sequence を選択した場合、Run ボタンをクリッ
クすると、機器は 1 つの測定周期を実行して停止します。　
Continuous を選択すると、アクイジションを停止するまで機器は
連続して稼働します。

12 チェック・マーク・イン
ジケータ

画面の左上隅のチェック・マーク・インジケータ（ ）は、その画
面用にアクイジション・ハードウェアが最適化されていることを示
します。
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表示固有のコントロール

ほとんどの表示では、よく使われるコントロールがグラフの周囲に配置されています。これらのコントロール
を使用すると、共通の設定にすばやくアクセスできます。なお、Settings コントロール・パネルでは、表示に
関するすべてのコントロールにアクセスすることができます。次の図と表に、ほとんどの表示で使用される共
通のアイコンを一部示します。

表 1: 共通のアイコン

番号 コントロール・アイコン 説明

1 ドロップダウン・リスト。このアイコンをクリックして、ド
ロップダウン・リストから値を選択します。
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表 1: 共通のアイコン （続き）

番号 コントロール・アイコン 説明

2 ノブ。このコントロールを選択する場合は、アイコンま
たはテキスト・リードアウトをクリックします。その後、
フロント・パネルのコントロール・ノブまたは矢印キー
を使用して値を変更したり、キーパッドから値を入力
することができます。

3 6.337 μs イタリック体の数字。自動的に選択されたコントロー
ルの値であることを示します。機器で使用する複数
のコントロール（RBW および Analysis Length など）
では、Auto モードを選択できます。Auto モードで
は、機器のソフトウェアが自動的に値を設定します。
値を変更してコントロールを Manual モードに切り替
えることができます。Auto モードに戻るには、値をク
リアしてから、Enter キーを押します。
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基本概念

リアルタイム・スペクトラム・アナライザ

当社のリアルタイム・スペクトラム・アナライザ（RSA6100A シリーズ・スペクトラム・アナライザなど）では、特許
取得済みの周波数マスク・トリガをオプションで利用することができます。この周波数マスク・トリガでは、スペ
クトラムの異常発生をとらえて信号を取り込めるように、スペクトラム・マスクを設定することができます。この
ため、入力信号を 100% チェックしてから取り込み、狙いを定めた間欠的な RF イベントを高確度でとらえる
ことができます。

DPX™ 技術により、RF 信号をライブ表示として観測でき、極端に短いトランゼント信号や、マルチレベル信
号、時間と共に変化するイベントを読み取ることができます。

RSA6100A シリーズ・スペクトラム・アナライザは、取り込んだ信号をさまざまな相関を取りながら表示すること
ができます。この機能は、デバイスのトラブルシューティングと信号の特性評価に役立ちます。すべての測
定は、同一の基本的な時間領域サンプル・データ・セットに基づいて実行されます。

測定表示

RSA6100A シリーズでは、汎用表示とアプリケーション固有の表示を任意に幾通りにも組み合わせることが
できます。

この例では、DPX スペクトラムのみが
ウィンドウに表示されています。
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この例では、スペクトラムと DPX スペ
クトラムの 2 種類が組み合わされて表
示されています。

複数の表示が開かれている場合、アク
イジション・ハードウェアを制御してい
る表示には、目印としてチェック･マー
クが付いています。別の表示のタイト
ル・バーをクリックすると、表示の優先
権が変わります。

この例は、4 つの表示を同じウィンドウ
に表示しています。

アクイジション・データ・ソースは、ライブ・アクイジションまたは保存したアクイジション・データ・ファイルのい
ずれかです。同じデータを複数の画面に並べて表示し、それぞれ異なる方法で観察することができます。た
とえば、電力と周波数（スペクトラム）の関係を表す画面とスペクトログラム・ダイアグラムを同時に表示できま
す。同じデータ・ソースを異なる画面の間で共有しているため、それぞれの画面には相関性があります。こ
のため、ある画面のポイントやポイントのセットは、同じアプリケーション・ウィンドウ内の他の画面内のポイン
トやポイントのセットと関連しています。
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表示の切り替え
RSA6100A シリーズでは、複数の表示方式がサポートされ、操作方法が簡素化されています。さらに、必要
に応じてより高度な機能を使用することもできます。次のような表示カテゴリがあります。

General Signal Vewing 表示：周波数または時間に対してプロットされる振幅、位相、周波数などの基本信
号パラメータのグラフを表示します。このカテゴリに該当するのが、スペクトラム、DPX、スペクトログラム、
時間オーバビュ、および位相対時間です。

General Purpose Digital Modulation 表示：これらの表示では、信号の復調と信号の解析の結果を複数
のドメインで表示します。このカテゴリに該当するのが、コンスタレーション、シンボル・テーブル、および
EVM 対時間です。これらの表示は、オプション 21 型の汎用変調解析で使用できます。

General Purpose RF Measurement 表示：RF 信号の自動測定の結果を表示します。このカテゴリに該当
するのが、ACPR、MCPR、および CCDF です。

Pulsed RF 表示：パルス RF 信号の拡張測定解析機能の結果を表示します。このカテゴリに該当するの
が、パルス統計、パルス・テーブル、およびパルス・トレースです。これらの表示は、オプション 20 型の拡
張測定解析機能で使用できます。
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表示の選択
スペクトラム・アナライザの表示は、簡単に選択できます。

1. Displays をクリックして、Select
Displays ダイアログ・ボックス
を開きます。

2. 目的のアプリケーション・フォ
ルダをクリックします。

各フォルダで使用できる表示
は、Available Displays ペイン
に表示されます。

3. 表示アイコンの 1 つをクリック
します。

4. Add をクリックして（またはアイ
コンをダブルクリックし）、選択
した表示を Selected displays
リストに追加します。追加する
表示が他にもあるときは、この
手順を繰り返します。

5. OK をクリックして、ダイアログ・
ボックスを閉じます。選択した
表示が自動的に開きます。

ヒント

フロント・パネルの Displays ボタンを押すと、Select Displays ダイアログ・ボックスが開きます。

表示を追加するには、アイコンをダブルクリックします。

表示を削除するには、次のいずれかの操作を行います。

Selected Displays リストの表示アイコンを選択してから、Remove をクリックします。

Selected Displays リストの表示アイコンをダブルクリックします。

選択されている表示の右上隅にある Close ボタンをクリックします。

複数のアプリケーション・フォルダの表示を組み合わせることもできます。

共通情報メッセージ

次の表に、通常の操作で表示される共通情報メッセージの一部を示します。
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表 2: 共通情報メッセージ

メッセージ 説明と推奨される対応

Acq BW too small for current
setup

この表示は、アクイジション帯域幅を現在のデータ・レコードに設定さ
れているアクイジション帯域幅よりも大きくする必要があります。次のい
ずれかの理由が原因と考えられます。

意図しなかった表示が選択されています。選択した表示では、測
定用途に適した確度やダイナミック・レンジを得るために要求したア
クイジション帯域幅が、結果的に不十分なものでした。

メッセージが表示されている表示を選択します。機器がまだデー
タを取り込んでいない場合は、Run をクリックします。

アクイジションが実行中ではないため、測定には直前のアクイジショ
ンより大きい帯域幅が要求されています。

Run をクリックして、より大きい帯域幅を持つ新しいアクイジショ
ンを実行します。

データは、呼び出されたファイルのデータです。

保存したデータのアクイジション帯域幅を大きくすることはでき
ません。小さい帯域幅ですむように測定の設定を調整する必要
があります。

Need swept acq or larger Acq BW 表示に掃引アクイジションが必要な場合でも、その他の表示は掃引
データを処理できません。これは、掃引データが選択した表示に合わ
せてカスタマイズされるためです。

目的の表示を選択すると、選択した表示の要件に合うようにアクイ
ジション設定が自動的に変更されます。

RBW increased to 100 kHz 現在の Spectrum Length または Analysis Length は、狭い RBW フィル
タを使用できるほど長くありません。

Length コントロールが Manual に設定されている場合は、その値を
大きくしたり、Auto に設定したりすると、Analysis Length を必要な
値まで大きくできます。

測定設定の変更

表示に使用されている設定で、信号の取り込みまたは処理方法を制御します。変更が可能な設定は、選択
した表示によって異なります。

設定にアクセスするには（ここでは、スペクトラム表示の場合）、次の手順に従います。
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1. Settings をクリックして、Settings コン
トロール・パネルを開きます。

2. 使用する信号またはテストに必要
なコントロールを調整します。コント
ロール・パネルのほとんどに、他の
関連するコントロールに簡単にアク
セスできるタブがあります。

ヒント

スクリーンに複数の表示がある場合、他の表示のいずれかの内部をクリックすると、その表示のコントロー
ル・パネルに変更されます。

機器のプリセット

設定をデフォルト値に復元するように機器をプリセットすることができます。

1. 機器をデフォルト設定にして起動
するには、フロント・パネルの Preset
ボタンを押すか、Setup メニューから
Preset を選択します。
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ヒント

Preset を使用しても、Config In/Out コントロール・パネル、または GPIB アドレス、Save/Export 設定また
は Auto Alignment 設定などの Tools メニューから指定された設定は変更されません。

信号の接続
スペクトラム・アナライザは、フロント・パネルに 1 つの RF 信号入力があります。入力に信号を接続する前
に、入力信号の要件を順守していることを確認してください。

注意： 機器または機器のアクセサリに静電気による損傷を与えないようにするには、ケーブルを機器の入
力に接続する前に、必ずケーブルの中央および外側の導体にたまっている静電気を接地によって放電して
ください。一端が未接続のケーブルを機器に接続したままにして、ESD (静電放電)アンテナが形成されな
いようにしてください。

必要な信号レベル

次の表に、リアルタイム・スペクトラム・アナライザの測定に使用できる入力信号レベルを表示します。信号
振幅と周波数（正規化ポイント）の確度は保証されています。許容入力値の範囲全体の信号を測定できま
すが、測定の確度は、測定対象信号の周波数や振幅に影響されます（詳細は、RSA6100A シリーズのデー
タ・シートを参照してください）。

RF 信号の入力範囲（CW またはピーク・エンベロープ・パワー）

変調測定要件 スペクトラム表示の要件

-50 dBm ～ +30 dBm DANL ～ +30 dBm

入力信号要件

特性 説明

入力インピーダンス 50 Ω

入力周波数レンジ

RSA6106A

RSA6114A

9 KHz ～ 6.2 GHz

9 KHz ～ 14 GHz

測定可能な最大連続入力電圧 1 W（+30 dBm）

最大電圧定格 ±40 V DC、AC カップリング

注意： 機器の損傷を防ぐため、1 ワット（+30 dBm）を超える CW 信号を接続しないでください。最大電圧定
格は±40 V DCです。最大パルス仕様は、75 W ピーク、10 μs パルス幅、0.001 デューティ・サイクル、≥30
dB の減衰。

RF 信号を接続するには、次の手順に従います。
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1. 信号をフロント・パネルの RF INPUT
コネクタに接続します。

ヒント

ソース信号が 1 ワット（+30 dBm）より大きい場合、ソース信号をアッテネータに接続します。アッテネータ
の出力を RF Input コネクタに接続します。

アクイジションの開始および停止

1. Run ボタンをクリックして、アク
イジションを開始します。

データを取り込んでいるときは、
ボタンのラベルの文字が緑で
表示されます。

2. Run ボタンを再度クリックして、
アクイジションを停止します。解
析の処理中の場合、シーケン
スが終了してから停止します。
機器が処理を停止すると、ボタ
ンのラベルの文字が緑から黒
に変わります。

ヒント

フロント・パネルの Run ボタンを押して、アクイジションを開始または停止します。

Run コントロール

Run メニューを使用すると、アクイジションと測定シーケンスを管理するコマンドにアクセスできます。Run メ
ニュー項目に関する情報については、オンライン・ヘルプを参照してください。デフォルトは Continuous が
選択されています。Continuous を選択すると、アクイジションを停止するまで、機器はデータを連続して取り
込みます。Single Sequence を選択すると、Run をクリックしたり、フロント・パネルの Run ボタンを押したりする
たびに、アクイジションを1回実行します。
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マーカ
マーカは、時間、周波数、電力などを測定するときに使用します。マーカは絶対値を測定するため、マーカ
間の差異の測定も行えます。

マーカを使用した周波数と電力の測定

次の手順は、周波数と電力を測定する場合に、Spectrum 表示でマーカを使用する方法を説明します。この
例は、すべてのマーカがオフで、信号がスクリーンに表示されていることを前提にしています。

1. Markers をクリックして、Anal-
ysis ウ ィ ン ド ウの下部の
Marker ツール・バーを開き
ます。

2. Marker ツール・バーのドロッ
プダウン・リストから、Add
Marker を選択します。

最初のマーカは、マーカの
基準（MR）が指定されていま
す。

3. Marker ツール・バーの矢印
ボタンを使用して、スクリーン
のマーカを移動します。タッ
チ・スクリーンまたはマウスを
使用して、マーカを目的の位
置にドラッグすることもできま
す。

4. 周波数と電力レベルは、そ
の表示のマーカのリードアウ
トから読み取ります。

動作

長方形のマーカは、リードアウトに絶対値を示します。選択したマーカのリードアウトは、表示の左上隅と
Marker ツール・バーに表示されます。

ダイアモンド形のマーカは、デルタ値（基準マーカを比較とした）を示します。選択したマーカのデルタ・
リードアウトは、表示の右上隅と Marker ツール・バーに表示されます。
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タッチ・スクリーンまたはマウスのいずれかで、トレースに沿ってマーカをドラッグすると、マーカは大きい
ポイントを探します。マーカは、マウスの位置から 20 トレース・ポイント以内に存在します。トレース・ポイ
ントの電流範囲内にピークがない場合、マーカは最大ポイントを見つけます。

ヒント

マーカがオフの場合、Marker ツール・バーまたはフロント・パネルにある Peak をクリックして、マーカの
基準（MR）を追加し、この基準を選択した表示のトレースの最大ピークレベルに指定します。

Marker ツール・バーの Table をクリックして、マーカ情報を示す表形式の表示を開きます。

Marker ツール・バー

Marker ツール・バーには、マーカと連携して機能するコントロールがあります。(表 3 参照)。これらのコント
ロールの一部は、フロント・パネルのコントロールと同様に動作します。

表 3: Marker ツール・バー

アイコン 説明

Define Markers コントロール・パネルを開きます。このコントロールパネ
ルは、マーカの追加および削除とマーカ・パラメータの設定に使用し
ます。

機器の測定周波数を選択したマーカの周波数に設定します。このボ
タンは、選択した表示の水平軸に周波数を設定する場合にのみ表示
されます。

マーカを、トレースの最大ピーク・レベルに移動します。最大ピークは、
垂直軸の正と負の値のいずれの場合も（周波数エラーまたは位相エ
ラーなど）、表示内の最大値または最小値のいずれかになる可能性が
あります。

選択したマーカを、現在位置の左側の次のピークに移動します。

選択したマーカを、現在位置の右側の次のピークに移動します。

選択したマーカを次に小さいピーク値に移動します。ピークの値は、
ピーク振幅の絶対値を参照します。マーカを繰り返し移動する場合、
次のピークの位置に応じてあらゆる方向に移動できます。

選択したマーカを次に大きいピーク値に移動します。ピークの値は、
ピーク振幅の絶対値を参照します。マーカを繰り返し移動する場合、
次のピークの位置に応じてあらゆる方向に移動できます。

表示内のマーカ・テーブルを開いたり、閉じたりします。

マーカの追加

最大 5 つのマーカを設定できます。最初のマーカ（MR）は、基準マーカです。他のマーカ（M1、M2、M3、
および M4）は、絶対値を表示したり、マーカおよび参照マーカ間の差分値と絶対値の両方を表示したりで
きます。

別のマーカを追加するには、ツール・バーのドロップダウン・リストから、Add Marker を選択します。
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マーカの定義

Define Markers コントロール・パネルで、マーカの設定を定義します。

1. Define をクリックして、Define Mark-
ers コントロール・パネルを開きます。

コントロール・パネルは、次の目的で使
用します。

マーカを追加または削除します。

マーカをオフにします。

マーカを特定のトレースに割り当て
ます。

マーカのリードアウトを絶対値また
はデルタ値に設定します。

しきい値と偏位値を定義します。

ヒント

Marker ツール・バーの Define の横のドロップダウン・リストから、マーカの追加または削除を実行できま
す。

タッチスクリーン･アクション
画面上にタッチスクリーン･アクション・メニューを表示して、マーカ設定や波形の表示方法を変更することが
できます。このメニューを表示するには、ディスプレイに指を触れ、1 秒押さえてから放します。また、マウス
の右ボタンをクリックすることでも、表示することができます。

タッチスクリーン･アクション・メニューの
中には、マーカが定義されているとき
にしか選択できない項目もあるので注
意してください。

タッチスクリーン･アクション・メニュー
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表 4: タッチスクリーン･アクション・メニュー

アイコン メニュー項目 説明

Select マーカを選択し、その位置を調整します。

Span Zoom 選択されたポイント周辺のグラフ領域をズームします。グラフ画面の目
的のポイントに触れてドラッグし、その周辺のスパンを増加または減少
させます。Span Zoom でスパン・コントロールを調整すると、アクイジショ
ン帯域幅に影響する場合があります。

CF Pan 水平移動によって、中心周波数を調整します。

Zoom グラフの水平軸および垂直軸スケールを調整します。最初に十分な
動きがあったときのその方向が、最初の調整のスケールになります。
最初の動きと交差する方向に30 ピクセル以上動かすと、今度はその
方向の調節ができるようになります。

左または下にドラッグすると、ズーム・アウトされ、波形が縮小されて表
示されます（スケール値が増加します）。右または上にドラッグすると、
ズーム・インされ、波形が拡大されて表示されます（スケール値が減少
します）。

Pan 波形の水平および垂直位置を調整します。最初に十分な動きがあっ
たときのその方向が、最初の方向の移動になります。最初の動きと交
差する方向に30 ピクセル以上動かすと、今度はその方向の移動がで
きるようになります。

— Reset Scale 水平軸および垂直軸スケールおよび位置の設定をデフォルト値に戻
します。

— Marker to peak 選択されたマーカを最高のピークに移動します。オンになっているマー
カがない場合、このコントロールにより自動的にマーカが追加されま
す。

— Next Peak 選択されたマーカを次のピークに移動します。選択肢は、次の左、次
の右、次の低地点（絶対）、および次の高地点（絶対）です。

— Add marker グラフの水平方向の中央に位置する新しいマーカを定義します。

— Delete marker 最後に追加したマーカを削除します。

— All markers off すべてのマーカを削除します。

印刷
スクリーンやスクリーンの内容（スクリーン・ショット）のコピーをプリンタまたはファイルに出力できます。

1. フロント・パネルの Print ボタンを押
すか、File メニューから Print を選
択します。
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2. Print ダイアログ・ボックスで詳細情
報を入力し、OK をクリックします。

Print ダイアログ・ボックスは、Mi-
crosoft Windows 標準の Print ダイ
アログ・ボックスです。プリンタのコ
ントロールは、ご使用のプリンタに
よって異なります。

データの保存
将来使用するために、さまざまなタイプのデータを保存することができます。

1. File メニューから Save As. . . を選
択して、Save As ダイアログ・ボック
スを開きます。

2. セットアップを保存するフォルダに
移動するか、デフォルトの位置を使
用します。

3. ファイル名を入力します。

4. 保存するファイルの種類を選択しま
す。 (表 5 参照)。

5. Save をクリックします。

ヒント

File > Save を選択するか、Save ボタンを押してファイルに情報を保存する際は、前回保存したときと同
じ名前、パス、およびデータ型を使用します。同じファイルが既に存在している場合、Tools > Options >
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Auto Filename コントロール・パネル・タブで前回と同じオプションを選択していると、名前のサフィックス
の数字が増加します。

File > Save As を選択すると、Windows 標準の Save ダイアログ・ボックスが開き、ここでファイル名を編集
したり、保存するデータ型を選択したり、ファイルを格納するフォルダを選択できます。

表 5: 保存用のファイルの種類

ファイルの種類 説明

Setup files Tools メニュー（Alignments と Options）または Config In/Out コントロー
ル・パネルで指定される設定以外の、すべての設定表示に関するセッ
トアップ情報をすべて保存します。

Results Export files 選択した表示のトレース・データと数値データを保存します。トレース・
データと数値データは、CSV 形式のテキスト・ファイルとして保存され
ます。

Picture (PNG/JPG/BMP) スクリーンのグラフィック表示を、指定したフォーマットで保存します。こ
のオプションは、レポートおよびその他のアプリケーションがグラフィッ
クを含む場合に便利です。マーカのリードアウトおよびその他の情報
が含まれています。

Selected Trace トレースを保存したときの表示に後で呼び戻せるように保存します。

Data (acquisition data and acqui-
sition data export)

データを保存し、RSA6100A シリーズ・リアルタイム・スペクトラム・アナ
ライザで再度解析したり、CSV（カンマ区切り値）データとして外部ソフ
トウェアで使用したりします。

データの呼び出し
RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザに保存されているアクイジション・データやセット
アップ・ファイルを呼び出すことができます。

1. フロント・パネルの Recall ボタンを
押すか、File メニューから Recall を
選択します。
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2. Open ダイアログ・ボックスで、ファイ
ルの位置を参照します。

3. ファイルを参照しない場合は、Files
of Type に表示されるファイルの種
類を選択します。

4. ロードするファイル名をダブルクリッ
クします。

ヒント

電流グラフの X 軸レンジ内に一致しない X 軸レンジを持つトレースを呼び出す場合、トレースは表示され
ません。小さい矢印は、呼び出されたトレースの方向のスクリーンの外を指します。Frequency and Span（ま
たは Span and Offset）コントロールを使用して、スペクトラム表示のスクリーンにトレースを合わせます。他の
表示では、Horizontal Scale and Offset（スペクトラム表示でも使用可能）を使用します。これらのコントロール
は、Settings > Scale タブにあります。

高度な手法

トリガのセットアップ

RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザは、電力レベル・トリガ、ライン・トリガ、外部トリガ
のほか、リアルタイム周波数領域トリガ（オプション 02 型）を備えています。トリガ・イベントは信号をシームレ
スに取込むための時間の基準ポイントとして使用されます。この結果、スペクトラム・アナライザは、プリトリガ
とポストトリガのいずれの情報もストアすることができます。

スペクトラム・アナライザには、次の 2 種類のトリガ・モードがあります。

Free Run モード：: Free Run モードの場合、機器は、トリガ条件を一切考慮せずにアクイジションを初期
化します。また、信号を高速かつ簡単に確認することができます。データ・レコードを収集する時間を特に指
定する必要がなければ、Free Run は一般に、スペクトラム表示に適しています。
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Triggered モード：: Triggered モードでは、機器はトリガ・イベントを認識した場合にアクイジションを初期化
します。トリガ・イベントを定義する条件は、選択したトリガ・ソースによって異なります。トリガ・イベントをモニ
タする信号を選択する場合に使用可能なソースが複数あります。

Triggered モードを選択すると、ソースを選択する必要があります。次のトリガ・ソースから選択します。

RF Input

Trig In

Trig 2 In

Gated

Line

トリガ・ソースを選択すると、トリガ・イベントを指定する追加パラメータを設定することができます。RF In put
をトリガ・ソースとして指定する場合、次の 2 種類のトリガから選択できます。

Frequency Mask トリガ：: Frequency Mask トリガを選択すると、周波数領域の信号がマスクを違反した場
合に、機器をトリガできます。リアルタイム周波数帯域内に、トリガ・イベントが生成されるように条件を定義
するマスクを書き込めます。このトリガでは、強い信号が存在する場合も弱い信号でのトリガが可能です。ま
た、間欠的に発生する信号の取り込みにも便利です。

Power トリガ：: Power トリガを選択すると、時間領域信号の特性に基づいて機器をトリガします。入力デー
タを dBm でのユーザ選択レベルと比較します。時間領域帯域幅を選択し、立上りエッジまたは立下りエッ
ジでトリガできます。

トリガ・イベントの定義に加え、トリガ・コントロール・パネルの適切なタブを選択し、次のパラメータを定義す
ることもできます。

取り込んだデータ・レコード内のトリガが発生する場所とトリガを一定の時間遅らせるかどうかを定義す
る時間パラメータ。　

掃引アクイジション・モードで各セグメントをトリガする Advanced パラメータ。

トリガ・パラメータへのアクセス

1. Trig をクリックして、Trigger コント
ロール・パネルを開きます。

2. 以下の手順で示すように、Trigger
コントロール・パネルのタブを 1 つ
クリックして、トリガ・パラメータを定
義します。

3. Event タブは、トリガ・イベントを定
義するパラメータを設定するときに
使用します。パラメータは、トリガの
ソースと種類の選択によって異なり
ます。
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4. Time タブは、トリガ・イベントの位置
を制御するパラメータを設定すると
きに使用します。

5. Advanced タブは、掃引アクイジショ
ン・モードの各セグメントでトリガす
るかどうかを選択するときに使用し
ます。

ヒント

他にも次の方法で Trigger コントロール・パネルにアクセスできます。

フロント・パネルの Trigger ボタンを押します。

Setup メニューから Trigger . . . を選択します。
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周波数マスクの作成

周波数マスクを作成するには、Mask Editor を使用します。マスクは、周波数と振幅で定義する一連のポイ
ントですTrigger コントロール・パネルから Mask Editor にアクセスできます。（この手順は Spectrum 表示を
使用します）。

1. Trig をクリックして、Trigger コント
ロール・パネルを開きます。

2. コントロール・パネルの Event タブ
を選択します。

3. ソースを RF Input に設定します。

4. Type を Frequency Mask に設定し
ます。

5. Mask Editor をクリックして、Mask
Editor を開きます。

Mask Editor は、グラフに Spectrum
表示のトレースを表示して開きます。

6. ツール・バーの New をクリックしま
す。この操作では、既存のマスクを
削除し、デフォルトの 6 ポイントのマ
スクを作成します。
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7. マスク内の任意のポイントをクリック
して、それを選択します。

グラフ内で選択したポイントの周波
数と振幅が、ハイライト表示されま
す。

8. ポイントを編集するには、次のいず
れかの操作を行います。

マウスでポイントをドラッグ・アン
ド・ドロップします。

周波数と振幅を表に入力します。

上下矢印キーで振幅を調整し、
左右矢印キーで周波数を調整
します。

ヒント

新しいポイントを追加するには、表示スクリーン上で右クリックします。

グラフに新しいポイントを追加する場合は、Add Points をクリックしてから、グラフ上でクリックします。

グラフ内の次のポイントを選択する場合は、Next をクリックします。

選択したマスク・ポイントを削除する場合は、X（削除ボタン）をクリックします。

マスク・ファイルを保存し、Mask Editor で作業を続行する場合は、Save をクリックします。

前に保存されたマスク・ファイルを読み込んで編集する場合は、Open をクリックします。
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トリガ条件の定義

マスクをセットアップしたら、マスク違反の有無でトリガするかどうかを選択することができます。

1. 条件を選択します。

以下に選択内容を示します。(表 6
参照)。コントロール・パネル下部の
アイコンは、True または False とみ
なされるものを特定します。

2. Triggered をクリックします。

トリガ条件が一致すると、機器はトリ
ガされます。

表 6: トリガ違反

違反 説明

T 信号がマスクを違反すると（ラインの上）、機器はトリガされます。

F 信号がマスク内にポイントを持たないと、機器はトリガされます。

T > F 1 つのトランザクションでトリガ・イベントを定義します。信号は、マスク
の内部にある（違反）場合、マスクの外部（無違反）に移動する必要が
あります。

F > T 1 つのトランザクションでトリガ・イベントを定義します。信号は、マスク
の外部にある場合、マスク内部に移動する必要があります。

T > F > T 2 つのトランザクションでトリガ・イベントを定義します。信号は、マスク
の内部から開始され、マスクの外部へ出てから、マスク内部に入る必
要があります。

F > T > F 2 つのトランザクションでトリガ・イベントを定義します。信号は、マスク
の外部から開始され（無違反）、マスク内部に入ってから、マスク外部
に出る必要があります。

アクイジションの制御

2 つ以上の表示が開いている場合、1 つの表示がアクイジション・システムを制御します。選択した表示のア
クイジション要件によって、アクイジション・ハードウェア・パラメータが設定されます。アクイジション・パラメー
タは、選択した表示用に最適化されますが、他の表示にとって最適ではない可能性があります。この場合、
その他の表示は最適なパフォーマンスを維持できず、結果的に効果を上げられない場合があります（その
ため、呼び出されたデータを解析する際、測定して結果を出そうとしても、測定の設定すべてに適合できな
い場合もあります）。

ハードウェア・アクイジション・パラメータを制御する表示を指定するには、その表示の任意の場所をクリックし
ます。複数の表示がある場合、ハイライトされた表示がハードウェア・アクイジション・パラメータを制御します。
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この例では、スペクトラム表示と DPX ス
ペクトラム表示の2 種類の表示がありま
す。DPX スペクトラム表示のハイライト
されたタイトル・バーは、表示が選択さ
れていることを示しています。

画面の左上隅にあるチェック・マーク・
アイコンは、アクイジション・ハードウェ
アがスペクトラム表示用に最適化され
ていることを示しています。

アクイジション・ハードウェアを制御しない表示もあります。このような表示は、取り込まれたデータだけを示し
ます。同じパラメータを共有する表示もあります。この場合、これらの表示のいずれか 1 つがアクイジション・
ハードウェアを制御すると、アクイジション・パラメータは、すべての表示に対して最適化されます。
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競合するアクイジション要件での測定

RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザは、複数の測定の組み合わせを開くことができま
す。目的の表示を選択すると、適切な解析とアクイジションのパラメータが自動的にセットアップされます。

測定がアクイジション・パラメータと競合する場合、現在選択されている表示が優先されます。次の例は、あ
る表示がリアルタイム・データ (振幅対時間測定など) を必要とし、別の表示が掃引データ (広範囲なスパン
が設定されたスペクトラム・グラフなど) を必要とする場合の互換性のない測定設定を示します。

1. フロント・パネルの Preset ボタンを
押し、機器の設定をデフォルト設定
に戻します。

2. 信号の周波数に合わせて機器を調
整した後、スパンを設定します。

3. Displays をクリックして、Select Dis-
plays ダイアログ・ボックスを開きま
す。

4. General Signal Vewing フォルダを選
択します。

5. Amplitude vs Time アイコンを選択
します。

6. Add をクリックして、そのアイコンを
Selected Displays リストに追加しま
す。

注： Spectrum表示が Selected Displays
リストにまだ存在しない場合は、Spec-
trum 表示を追加してください。

7. ダイアログ・ボックスを閉じます。
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8. Run をクリックして、データの取り込
みを開始します。

9. Spectrum 表示のスパンを 200 MHz
まで大きくします。

Spectrum が選択された表示なの
で、アクイジション・パラメータは自
動的に表示の要求に適合するよう
に調整されます。200 MHz スパン
は、機器のリアルタイム帯域幅を超
えています。その結果、機器のモー
ドは掃引に変更されます。

10.ステータス・バーを確認します。リー
ドアウトの "Swept" は、アクイジショ
ンが掃引されていることを示します。

アクイジションが "Real Time" と表
示されている場合、すべての測定
は通常実行されています。アクイジ
ションが掃引モードの場合、実行で
きるのは選択された表示のみです。
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11.Amplitude vs Time 表示をクリックし
て、アクティブな表示にします。

選択された表示はリアルタイムでな
ければならないため、アクイジション
はリアルタイムに戻ります。データは
現在、Amplitude vs Time 表示に適
応していますが、Spectrum 表示が
必要な周波数のフルレンジには対
応していません。

その場合、Spectrum 表示は実行で
きません。

12. Spectrum 表示のスパンを 40 MHz
まで小さくします。これで、アクイジ
ションは再度リアルタイムになりまし
た。

13. ステータス・バーのリードアウトを
チェックして、アクイジションがリア
ルタイムであることを確認してくださ
い。

Spectrum とAmplitude vs Time の両
表示を動作できます。

信号の検索

RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザを使用すると、パワー・レベルが変化する信号を
検索できます。あるパワー・レベルを超えたときに一致したものとみなしたり、パワー・レベルおよび周波数レ
ンジのリミットを指定するマスクを作成できます。検索するトレースを選択して、一致したものがあった場合に
行う動作を指定できます。
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トレースを検索するには、次の手順を実行します。

1. Spectrum 画面を開きます。すでに
開いている場合は、Spectrum 画面
を選択します。

2. Tools > Search を選択します。

3. Enable Search チェック・ボックスを
選択します。

4. Search in ドロップダウン・リスト・ボッ
クスから検索するトレースを選択し
ます。

5. Search in リストで選択したトレース
が目的のトレースか確認し、Show
ボックスがチェックされていることを
確認します。
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6. 検索内容を Search for ドロップダウ
ン・リストから選択して指定します。

指定したレベルより上または下の信
号レベルを検索するには、is greater
than または is less than を選択しま
す。

周波数によって変動する信号レベ
ルを検索するには、is outside mask
または is inside mask を選択しま
す。検索マスクのリミットを指定する
には、Edit limits ボタンをクリックし
ます。

グラフ画面のオレンジ色の影付き
領域は、そこに信号が来たときに一
致とするレベルを示します。

greater than 検索が選択されたときの画面

outside mask 検索が選択されたときの画面
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7. Actions タブをクリックして、一致し
たものがあったときのスペクトラム・ア
ナライザが行う処理を指定します。

スペクトラム・アナライザは、実行
モードにより、一致したものがあっ
たときに最大 5 つまでの処理を行
うことができます。Run モードでは、
スペクトラム・アナライザは、ビープ
音による通知、アクイジションの停
止、アクイジション・データの保存、
トレース・データの保存、および画
面のピクチャの保存を行うことがで
きます。Replay モードでは、ビープ
音による通知、解析の停止を行うこ
とができます。

8. 一致したものがあったときにスペク
トラム・アナライザに処理を実行さ
せるために、目的の処理を選択し
ます。

一致時に実行する処理は、どのよ
うな組合せでもかまいません。すべ
ての処理を選択すると、一致したも
のが見つかったときに、すべての処
理が実行されます（Run モード）。

9. 閉じるボックスをクリックして、Search
コントロール・パネルを消します。

10.RUN ボタンを押して、検索を初期
化します。

入力データに一致したものがある
と、グラフ画面に赤いラインが表示
されます。ツール・バーの Replay ボ
タンをクリックすると、現在のデータ・
レコードの検索が初期化されます。
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補正テーブルの使用

RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザでは、外部機器の利得や損失を考慮して信号表
示および測定結果を補正することができます。単一の利得値を指定したり、周波数に基づいて利得／損失
値を調整する外部損失テーブルを使用できます。
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外部利得／損失の補正を指定するには、次の手順を実行します。

1. Ampl ボタンを押して、Amplitude コ
ントロール・パネルを表示します。

2. External Gain/Loss Correction タブ
を選択します。

3. 定数補正率を適用するには、 Ex-
ternal Gain value チェック・ボックス
を選択します。値をテキスト入力ボッ
クスに入力します。

注： 正または負の利得値を入力できま
す。正の値は利得を表し、負の値は損
失を表します。

4. 周波数に依存する利得／損失値を
補正するテーブルを使用するには、
External Loss Tables の下のチェッ
ク・ボックスをクリックします。

3 つの外部損失テーブルをすべて
同時に使用できます。したがって、
アンテナ、プリアンプ、ケーブル用
に別の外部損失テーブルを使用で
きます。

5. 外部損失テーブルの内容を編集す
るには、編集するテーブルの Edit
ボタンをクリックします。
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6. 補正する機器の損失特性に合わせ
て、表の内容を編集します。完了し
たら、OK をクリックします。

注： テーブルには正または負の値を入
力できます。External Gain の値の設定
とは対照的に、正の値は損失を表し、
負の値は利得を表します。

Table Editor の使用方法の詳細は、
Help > User Manual を選択して、Ex-
ternal Loss Tables のインデックスを調
べてください。

7. それぞれの外部損失テーブルのタ
イトルを変更できます。タイトル・ボッ
クスを選択して、新しいタイトルを入
力します。

タイトルはたんなるラベルにすぎま
せん。ロードまたは保存したテーブ
ルのファイル名とは関係ありません。

8. 変更し終えしたら、閉じるボックス
をクリックして、Amplitude コントロー
ル・パネルを消します。

オーディオ復調の使用

RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザは、オーディオ信号を復調できます。これにより、
不明な無線信号の特定に役立てることができます。DPX Spectrum 画面の Settings コントロール・パネルか
ら Audio Demod タブにアクセスできます。
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オーディオ信号を復調するには、次の手順を実行します。

1. Displays ボタンを押して Select Dis-
plays ダイアログ・ボックスを表示し
ます。

2. General Signal Viewing フォルダを
選択します。

3. DPX Spectrum アイコンをダブルク
リックして、それを Selected Displays
リストに追加します。

4. OK をクリックしてダイアログ・ボック
スを閉じます。DPX Spectrum 画面
が開きます。

5. Settings フロント・パネル・ボタンを
押して DPX Spectrum Settings コン
トロール・パネルを表示します。

6. Audio Demod タブをクリックして、
Audio Demod コントロール・パネル
を表示します。

7. On ボタンをクリックして、オーディオ
復調を有効にします。

8. 復調タイプを指定するには、AM ま
たは FM ボタンをクリックします。

注： AM および FM ボタンはたんに復
調タイプを選択するだけで、周波数帯
域は指定できません。

9. 必要に応じて中心周波数を設定し
ます。
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レシーバ周波数（復調する周波数）
をマーカまたは周波数コントロール
（フロント・パネルの Frequency ボタ
ンまたはツール・バーの Freq コン
トロール）で指定します。Tune with
設定を使用して、レシーバ周波数
の指定にマーカまたは周波数コン
トロールのいずれかを使用するかを
指定します。

10.Tune with ドロップダウン・リストから、
マーカまたは周波数コントロールを
選択します。

11.選択したマーカが有効でない場合
（有効な場合は画面に表示されま
す）、ツール・バーの Markers ボタ
ンをクリックして、Markers ツール・
バーを表示します。

12.Marker ツール・バーの Define ボタ
ンをクリックして、Define Markers コ
ントロール・パネルを表示します。

13. 必要に応じて、Add をクリックして
マーカを追加します。
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14. Settings ボタンをクリックして、Audio
Demod コントロール・パネルに戻り
ます。

15.Receiver BW 値入力ボックスに値を
入力して、必要なレシーバ帯域幅
を設定します。

16.レシーバ周波数を設定します。

Tune with 設定でマーカを指定し
た場合、マーカを必要な周波数に
ドラッグします。フロント・パネル・ノ
ブまたはマウス・ホイールを使用し
て、マーカの位置を微調整します。
Tune with 設定でFrequency control
を選択した場合、フロント・パネルの
FREQ ボタンを押して、フロント・パ
ネル・ノブを調整するかツール・バー
の Freq 設定を使用して、必要な周
波数を設定します。

レシーバ周波数は、Receiver Freq
として Tune with と Receiver BW 設
定の間に表示されます。

17. 復調信号が聞こえるように、Audio
Gain 設定を調整します。サウンド・
レベルは Windows のボリューム・コ
ントロールの設定によっても影響さ
れるので、注意してください。

RSA6100A シリーズ・クイック・スタート・ユーザ・マニュアル 55



操作

56 RSA6100A シリーズ・クイック・スタート・ユーザ・マニュアル



アプリケーション

アプリケーション

ここでは、スペクトラム・アナライザを使用した代表的なアプリケーションの例を紹介します。それぞれの例で
は、機器の電源が入っていて信号に接続されていることが前提となっています。ご使用の信号が、例に出て
くる信号と異なっている可能性があります。その場合、機器の設定を変更してご使用の信号が表示されるよ
うにする必要があります。

注： 一部の例については、保存されたアクイジション・データ・ファイルに基づいています。設定ファイルは、
C:\RSA6100A Files\Sample Data Records フォルダに格納されています。これらのファイルは File > Recall メ
ニューから読み込み、以下に紹介するアプリケーションで使用することができます。

変調解析
RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザを使用すると、信号を取得し直すことなくさまざま
な方法で信号を解析することができます。以下の例は、オプション 21 型がインストールされた RSA6100A シ
リーズ・リアルタイム・スペクトラム・アナライザを使用して QPSK 信号を復調し、複数のドメイン内の信号を分
析する方法を示しています。この例では、アナライザを使用して次の操作を行う方法について説明します。

QPSK 信号を復調し、コンスタレーション・ダイアグラムを表示する。

信号品質表示を使用し、EVM（変調確度）やその他の重要な特性を測定する。

時間領域内の信号の位相を表示する。

マーカを使用し、シンボル・テーブル表示、コンスタレーション表示、位相対時間表示の各結果の相関
を表示する。

注： 以下の例は、QPSK のサンプル・データ・ファイルに基づいたものです。必要であれば、QPSK のサン
プル・データ・ファイル（ファイル名は QPSKDemo.tiq）を読み込み、このアプリケーションで使用される手順
を作成し直すことができます。以下の例で使用される信号設定は、このサンプル・ファイル内の信号に基づ
いたものです。ライブ信号を使用する場合、設定が異なる可能性があります。
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信号を復調する

1. フロント・パネルの Preset ボタンを
押し、機器の設定をデフォルト設定
に戻します。

2. 機器を 2.13 GHz に調整し、スパン
を 20 MHz に設定します。

3. Displays をクリックして、Select Dis-
plays ダイアログ・ボックスを開きま
す。

4. General Signal Viewing フォルダを
選択します。

5. Time Overview アイコンを選択しま
す。

6. Add をクリックし、Time Overview ア
イコンを Selected Displays リストに
追加します。

7. GP Digital Modulation フォルダを選
択します。

8. Signal Quality アイコンを選択しま
す。

9. Add をクリックし、アイコンを Selected
Displays リストに追加します。

10.手順 8 と 9 を繰り返して Constella-
tion アイコンをリストに追加し、ダイ
アログ・ボックスを閉じます。
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GP Digital Demodulation フォルダ内の表示は、同じ変調コントロールと詳細パラメータ・コントロールを共有
しています。これらのコントロールは、各表示の Settings コントロール・パネルで使用することができます。

11. Signal Quality 表示を選択して Set-
tings をクリックします。

12.Modulation タブを選択します。

13.Modulation Type を QPSK に設定し
ます。

14. Symbol Rate を 3.84 MHz に設定し
ます。

15.Measurement Filter を RootRaised-
Cosine に設定します。

16.Reference Filter を RaisedCosine に
設定します。

17.Filter Parameter を 0.220 に設定し
ます。

18.コントロール・パネルを閉じます。

信号を解析する

定性的方法および定量的方法の 2 つの手法を使用して、信号を解析することができます。

Constellation 表示は、図のようになり
ます。QPSK 信号の場合、各先端部
は 4 つの密な点の集合で表示され
ます。表示が異なる場合、Frequency、
Modulation Type、Symbol Rate、Filters
の各設定を確認してください。

EVM vs. Time 画面のトレースに注目
してください。グラフには、各トレース・
ポイントでの EVM 値がパーセント単位
で表示されています。解析期間全体の
EVM の RMS 値は画面ウィンドウの底
部に表示され、その隣にピーク EVM 値
とそれが検出された時間（または記号）
が表示されます。
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解析長を手動で調整する

Time Overview 画面には、アクイジション・レコード全体が表示され、スペクトラム時間および解析時間の長
さとオフセットが表示されます。スペクトラム長とは、スペクトラムが計算されるアクイジション・レコード内の時
間のことです。解析長とは、その他の計測が行われるアクイジション・レコード内の時間のことです。解析長
は、シンボル・レートなどの測定パラメータで自動的に決定することも、手動で調整することもできます。

注： スペクトラム長およびスペクトラム・オフセットは、スペクトラム時間モードが独立に設定されていないと、
独立に設定することはできません。スペクトラム時間モードは、Analysis > Spectrum Time コントロール・パネ
ル・タブで変更できます。Time Overview 画面のスペクトラム時間を示す赤いラインは、スペクトラム時間モー
ドが独立に設定されている場合のみ表示されます。

1. Time Overview 画面で、Analysis

Length ボタンを選択します（ ).
（アクイジションが実行されているこ
とを確認してください。RUN ボタン
が点灯していれば実行されていま
す）。

解析長は、グラフ上部の青いバー
で示されます。

2. 解析長を拡張します。解析長を拡
張するには、数値入力ボックスの値
を変更するか、影のない領域の右
エッジをドラッグします。

Analysis Length 設定を変更すると、
復調画面の測定結果の計算時に使
用されるデータ量が変更されます。
画面内の影の部分は、解析時間の
範囲を示しています。

解析長を拡張すると、機器によって
自動的にアクイジション長の設定値
が大きくなり、新しい解析の設定に
対して十分なサンプルが収集され
ます。デフォルトでは、自動的に決
定されたアクイジション長は、解析
長と同じかそれよりわずかに大きく
なります。
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3. Analysis Offset ボタンを選択します

（ ).

4. 解析オフセットの設定値を大きくし
ます。この値を大きくするには、数
値入力ボックスの値を変更するか、
影のない領域の左エッジをドラッグ
します。

解析オフセットの値を大きくした結
果、解析時間内にアクイジション・
レコードが足りなくなってしまった場
合、機器によって自動的にアクイジ
ション長が拡張され、追加のデータ
が収集されます。
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5. Analysis Offset の設定を 20μs に
変更します。

6. Run をクリックしてアクイジションを
停止します。

7. Analysis Offset の値をもう一度大き
くします。

機器が停止しているため、新しいア
クイジションを実行してより長いデー
タ・レコードを取り込むことはできませ
ん。要求された解析時間内でデー
タ・レコードが足りなくなった場合、
実際の解析時間が短くなります。
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トランゼント信号を取り込む
RSA6100A シリーズ・スペクトラム・アナライザは、強い信号によって隠されてしまう可能性のある発生頻度の
低いトランゼント信号や低出力信号を識別することができます。こうした信号の存在を確認した場合、次に示
すツールの一部を使用して信号の詳細を取り込み、詳細を検証してその原因を判断することができます。

Max Hold 機能を使用し、CW 信号以外の信号が存在するかどうかを確認する。

DPX スペクトラム表示を使用してトランゼント信号を表示する。

周波数マスクを作成し、周波数マスク・トリガを使用してそのマスクに違反するすべての信号を取り込む。

スペクトログラムを周波数マスク・トリガと共に使用し、時間領域と周波数領域でのマスク違反を表示する。

スペクトラム・アナライザ表示でトランゼント信号を表示する

従来のスペクトラム・アナライザを使用して正確な信号を表示する場合、掃引全体（取り込み時間）を通して
信号が安定した状態で存在している必要があります。しかし、一部のトランゼント信号によってまれに干渉
が発生する可能性があるため、従来のスペクトラム・アナライザでこうしたトランゼント信号を検出して取り込
むのは困難な場合があります。RSA6100A シリーズ・スペクトラム・アナライザには、こうしたトランゼント信号
の表示に役立つツールがいくつか用意されています。

注： 以下の例を実行するには、トランゼント信号が必要になります。スペクトラム・アナライザの入力に簡易
アンテナを取り付け無線送信機の無線信号を受信すると、トランゼント信号を取得することができます。携帯
電話帯域と ISM（産業、科学、医療）帯域には、さまざまな信号が存在しています。ほとんどの国では、ISM
帯域は 2.45 GHz に設定されています。
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1. フロント・パネルの Preset ボタン
を押し、機器の設定をデフォルト
設定に戻します。

2. 機器を必要な周波数に設定し、
スパンを調整して画面上に信号
を表示します。

3. Settings をクリックします。

4. Traces タブを選択します。

5. Trace 1 と Show が選択されてい
ることを確認します。

6. +Peak を選択します。

7. Max Hold を選択します。

Max Hold とは、含まれているす
べてのトレース間の周波数デー
タ・ポイントに対する最大振幅の
ことです。

8. コントロール・パネルを閉じます。

トランゼント信号が発生すると、Max Hold トレースによって表示されます。

DPX スペクトラム表示を使用してトランゼント信号を検出する

DPX スペクトラム表示では、ライン・トレースのほかにビットマップ・イメージを使用して信号が表示されます。
ビットマップ・イメージにより複数の値を持った信号を表示することができるため、同じ周波数で異なる時間
に発生した低レベル信号と高出力信号を表示することができます。

1. フロント・パネルの Preset ボタン
を押し、機器の設定をデフォルト
設定に戻します。

2. Displays をクリックします。
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3. General Signal Viewing フォルダを
選択します。

4. DPX Spectrum アイコンを選択し
ます。

5. Add をクリックし、Selected Displays
リストに追加します。

6. Selected Displays リストの Spec-
trum アイコンを選択します。

7. Remove をクリックし、リストからこ
のアイコンを削除します。

8. ダイアログ・ボックスを閉じます。
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9. 機器を調整して信号に合わせま
す。

10. スパンを調整します。

11. ドロップ・ダウン・メニューから、
Enable +Peak Trace を選択しま
す。この新しいトレースにより、各
DPX フレーム内のピーク値が検
出されます。

12. Settings をクリックし、DPX Spec-
trum Settings のコントロール・パ
ネルを開きます。

13.Traces タブをクリックします。

14.Function リストから Hold を選択
し、すべてのアクイジションのピー
ク値を取得します。

15.コントロール・パネルを閉じます。

ヒント

表示内容を消去して新たにポイントの収集を開始するには、グラフのすぐ上にある Clear をクリックします。

Max Hold 機能により、更新中に収集された最も高いポイントが表示されます。+Peak Trace には最も高いポ
イントが表示されますが、最大値より小さな信号はいずれの周波数でも表示されません。ただし、DPX ビット
マップ・トレースの場合は、こうした信号を表示することができます。
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16.Trace Selector から Bitmap を選択
します。

17. Settings をクリックし、DPX Spectrum
Settings のコントロール・パネルを開
きます。

18.Dot Persistence をクリックします。

19.パーシスタンス時間を大きくします。

パーシスタンス設定と輝度設定の値を
大きくすると、発生頻度の低い信号イ
ベントがよりすばやく表示されるように
なります。この例では、発生頻度の高
い信号は赤で表示され、発生頻度の低
い信号は青で表示されています。

これらの設定は、最大信号レベルより
小さな信号を表示する場合にも使用す
ることができます。たとえば、パルス信
号内に低レベル信号が存在する場合、
より低いパーシスタンス設定と輝度設
定が必要になることがあります。
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周波数マスク・トリガ

機器にオプション 05 型がインストールされている場合、マスク・エディタを使用してトランゼント信号のトリガ
用に周波数マスクを作成することができます。以下の手順を実行し、周波数マスクの作成に使用できる適
切なリファレンスを設定してください。

1. フロント・パネルの Preset ボタンを
押し、機器の設定をデフォルト設定
に戻します。

2. 機器を調整して信号の周波数に合
わせます。

3. スパンを調整します。

4. Settings をクリックして、Settings コン
トロール・パネルを開きます。

5. Traces タブを選択します。

6. Trace 1 を選択します（Show チェッ
ク・ボックスにチェックが入っている
ことを確認してください）。

7. Detection を +Peak に設定します。

8. Function を Max Hold に設定しま
す。

9. コントロール・パネルを閉じます。
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10.Trig をクリックして、Trigger コント
ロール・パネルを開きます。

11.Type を Frequency Mask に設定し
ます。

12.Mask Editor をクリックして、Mask
Editor を開きます。

13.Mask Editor を使用して信号用のマ
スクを作成します。 (40 ページ 「周
波数マスクの作成」 参照)。

スペクトラム・アナライザ表示で選択
したトレースは、Mask Editor 内で参
照用として使用されます。トレース
検出とトレース機能は、すべて使用
することができます。

14.Mask Editor を閉じます。

15.設定したいトリガ条件を選択します。

たとえば、少なくとも 1 つ以上の正
常なアクイジションが確認された後
の最初の違反が検出されたタイミン
グでトリガを起動したい場合、F > T
違反を選択します（影になっている
マスク・ライン内にポイントが表示さ
れている場合に、違反となります）。

16.Triggered をクリックします。

これで、違反が発生した場合にトリ
ガが起動されます。トリガが起動さ
れるタイミングが早い（実際の違反
ではなくノイズのため）と感じる場合
には、マスクを調整する必要があり
ます。
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時間領域と周波数領域でトランゼント信号を表示する

スペクトログラムにより、時間の経過と共に信号が変化する様子を表示することができます。スペクトログラム
表示を使用して、マスクに違反しているトランゼント信号を検証することができます。スペクトログラム表示を
周波数マスク・トリガと組み合わせて使用することにより、違反の発生頻度を表示し、問題の原因を解決する
ことができます。

1. Displays をクリックして、Select Dis-
plays ダイアログ・ボックスを開きま
す。

2. Spectrogram 表示と Time Overview
表示を追加します。

3. ダイアログ・ボックスを閉じます。
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4. Time Overview 表示を選択します。

5. Time Overview 表示にトランゼント信
号が表示されるまでAnalysis Length
の設定値を大きくします。

この図は、Spectrogram 表示によって表
示されるトランゼント信号の例を示して
います。Analysis Length の設定値を大
きくすると、各アクイジション内のスペク
トログラムのライン数も増えます。

Spectrogram 表示の右側のマークは、
各アクイジション・レコードの開始を表
しています。
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Spectrogram 表示の場合、1 つの表示内に時間領域と周波数領域の両方が表示されます。縦軸は時間を
表しています。新しいデータほど下に表示されます。横軸は周波数を表しています。Spectrum 表示と同じス
パンになっています。

1. Markers をクリックして Marker ツー
ル・バーを開きます。

2. Add Marker を選択し、いずれかの
マーカーを表示に追加します。

3. タイトル・バーをクリックして Spectrum
表示を選択します。

4. Spectrum 表示内の Spectrogram
Trace のチェック・ボックスにチェッ
クが入っていることを確認します。

Spectrum 表示内のスペクトログラム・ト
レースは、アクティブ・マーカーによっ
て Spectrogram 表示で選択されたライ
ンに対応しています。

注： アクティブ・マーカーがない場合、
Spectrum 表示内のスペクトログラム・
トレースにより、縦方向の Offset コント
ロールによって調整された Spectrogram
表示の最終結果が表示されます。

ヒント

スペクトラム・トレース 1、2、3、4 は、Time Overview 表示または Analysis コントロール・パネルの Spectrum
Time タブで選択された Spectrum Time に対するスペクトラムを表示しています。スペクトログラムの場合、
Time Overview 表示または Analysis コントロール・パネルの Analysis Time タブで選択された Analysis
Time を対象としています。
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パルス測定
これまで、パルス RF 測定の実行は困難なものでした。一部の測定方法には、特別に作成された専用ツー
ルが必要なものがありました。こうした専用ツールを適切に使用して確度と再現性を実現するためには、専
門の技術者が必要でした。当社のリアルタイム・スペクトラム・アナライザは、パルス測定の自動化を実現し
ています。オプション 20 型がインストールされた RSA6100A シリーズ・スペクトラム・アナライザにより、パルス
RF 測定用にこれまで必要とされてきた専用テスト・ツールが必要なくなります。

このアプリケーションにより、以下のパルス RF 測定の実行方法を説明します。

一連の RF パルスを、1 つのアクイジション・レコードに取り込む。

パルス・テーブルに表示する測定結果を選択する。

パルス・トレース表示を使用してパルスの形状を検証し、基準ポイントを測定する。

パルス統計表示を使用して、測定結果にトレンドと FFT の解析結果を表示する。

注： 以下の例を実行するには、パルス信号または適切な保存データ・レコードが必要になります。この例で
は、PulseDemo.tiq ファイルを使用します。このファイルは、C:\RSA6100A Files\Sample Data Records フォル
ダに格納されています。

パルスを取り込む

1. フロント・パネルの Preset ボタンを
押し、機器の設定をデフォルト設定
に戻します。

2. 機器のコントロールを調整し、画面
上に波形を表示します。

3. Displays をクリックして、Select Dis-
plays ダイアログ・ボックスを開きま
す。
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4. General Signal Viewing フォルダを
選択します。

5. Time Overview アイコンを選択し、
Selected Displays リストに追加しま
す。

6. Pulsed RF フォルダを選択します。

7. Pulse Table 表示と Pulse Trace 表
示を Selected Displays リストに追加
します。

8. OK をクリックして、ダイアログ・ボッ
クスを閉じます。

9. Frequency を 2.7 GHz に設定しま
す。

10.Time Overview 表示で、複数のパ
ルスが表示されるように Analysis
Length を設定します。

完全なパルスのみが認識されます。
完全なパルスとは、あるパルスの立
ち上がりエッジから次のパルスの立
ち上がりエッジまでのパルスのこと
です。

たとえば、この図のハイライト表示
された領域内にある最後のパルス
は、完全なパルスではありません。
次の立ち上がりエッジが測定範囲
外にあるためです。
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11.Pulse Table表示を選択して Settings
を選択します。

12.Measurements タブを選択します。

13.表示したい測定結果の形式を選択
します（この例の場合、Average ON
Power、Pulse Width、Rise Time を選
択します）。

14.コントロール・パネルを閉じます。

15.Pulse Table 表示にデータが表示さ
れたら、Run をクリックしてデータの
取得を停止します。

ヒント

機器が稼働状態の場合でも停止状態の場合でも、測定結果を取得することができます。機器を停止す
ると、すでに取り込んであるデータからの測定結果が見やすくなります。

取り込んだパルスのパラメータを測定する

パルスを取り込むと、パルス・トレース表示を使用して特定の測定結果についての詳細情報を表示すること
ができます。
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1. Pulse Table 表示から、いずれかの
測定結果を選択します。この例の場
合、Pulse 1 の Width 列のセルをク
リックします。

Pulse Trace 表示には、選択された
パルスの選択された測定結果に対
する振幅と時間のトレースが表示さ
れます。青のラインと矢印は、測定
がどのように行われたかを示してい
ます。

表示内の緑の矢印は、パルスの測
定に使用された電源のスレッショル
ドを示しています。このスレッショル
ドの設定が高すぎたり低すぎたりし
た場合、パルスは検出されなくなり
ます。Settings > Params タブで、電
源のスレッショルドを設定することが
できます。
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2. Pulse Trace 表示の Pulse コントロー
ルをクリックし、異なるパルス番号を
入力します。

Pulse Trace 表示に新しいパルスが
表示され、同時に Pulse Table 表示
内で選択されます。Pulse Trace 表
示と共に Pulse Table 表示を使用
し、パルスの測定結果を表示して解
析することができます。

Pulse Trace 表示で異なった測定結
果を選択することができます。Pulse
Trace 表示で選択された測定結果
は、同時に Pulse Table 表示内でも
選択されます。

3. スケールとオフセットのコントロール
を使用して、選択されたパルスの詳
細を拡大表示することができます。
たとえば、これらのコントロールを調
整して、図のように Rise Time の測
定結果を拡大表示することができま
す。

ヒント

垂直方向と水平方向のオフセット設定とスケール設定を最適化するには、Autoscale をクリックします。

スケールまたはオフセットを使用する場合、最初にオフセットのコントロールを調整して拡大表示したい
領域を画面の左端に移動し、次にスケールのコントロールを調整してこの領域を拡大します。

すべての測定パルス間の統計測定を確認する

パルス統計画面を使用して、すべての測定パルス間のトレンドや FFT を表示できます。最適な周波数分解
能と画面ダイナミック・レンジを得るために、解析時間内に多くのパルスを取り込む必要があります。
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1. Time Overview 画面の Analysis
Length を 19 ms に設定します。
Analysis Offset を 100 µs に設定し
ます。

2. Displays をクリックして、Select Dis-
plays ダイアログ・ボックスを開きま
す。

3. Pulsed RF フォルダを選択します。

4. Selected Displays リストから、Spec-
trum アイコンと Time Overview アイ
コンを削除します。

5. Pulse Statistics アイコンを Selected
Displays リストに追加します。

6. ダイアログ・ボックスを閉じます。
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アプリケーション

Pulse Statistics 表示により、選択さ
れた測定結果がすべての測定パル
スについてプロットされます。

7. 測定結果として Phase を選択しま
す。パルス単位の位相の測定結果
は、トレンド統計と FFT 統計を表示
する場合の適例です。

8. 統計トレースを FFT に変更します。

FFT の場合、周波数に対する振幅
のトレースがスペクトラムのように表
示されます（表示内で最も高い測
定結果に対する相対値が dB で表
示されます）。この表示は、パルス
信号内の干渉を検出する場合に便
利です。たとえば、スパイク信号が
60 Hz 付近で表示された場合、AC
電源からのカップリングが存在する
可能性があります。
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索引

索引

English terms
Analysis ウィンドウ, 23, 25
CF Pan

タッチスクリーン･アクショ
ン・メニュー, 33

Constellation 表示, 59
Digital 復調表示, 25
DPX スペクトラム表示, 64
EVM, 59
Free Run トリガ・モード, 37
General Signal Viewing 表示, 25
Marker ツール・バー, 32
Mask Editor

ポイントの追加, 40
ポイントの編集, 41

Max Hold, 64, 66
Max Trace, 66
Pan

タッチスクリーン･アクショ
ン・メニュー, 33

Preset, 28
システム設定, 29

Pulsed RF 表示, 25
Reset scale

タッチスクリーン･アクショ
ン・メニュー, 33

RF 信号の接続, 29
RF 信号の入力範囲, 29
RF 測定表示, 25
Run コントロール, 30
Run メニュー, 30
Select

タッチスクリーン･アクショ
ン・メニュー, 33

Signal Quality 表示, 59
Span Zoom

タッチスクリーン･アクショ
ン・メニュー, 33

Time Overview 表示, 60
Trigger

コントロール・パネル, 38
Zoom

タッチスクリーン･アクショ
ン・メニュー, 33

あ
アクイジション

開始, 30
競合, 44
制御, 42
停止, 30
データ・ソース, 24

アクイジションの開始, 30
アクイジションの制御, 42
アクイジションの停止, 30
アクセサリ

オプショナル, 2
スタンダード, 1
電源コード, 1
マニュアル, 1

アップグレード
ソフトウェア, vii, 11

アプリケーション, 57
トランゼント信号の取り込

み, 63
パルス測定, 73
変調解析, 57

安全にご使用いただくため
に, iii

い
イタリック体の数字, 22
違反

トリガ・マスク, 42
印刷, 34

う
ウィンドウ

解析, 23
選択された, 42

受入検査, 10

お
オプショナル・アクセサリ, 2
オプション, 2

電源コード, 1
主な機能, vi
オーディオ復調, 52

か
解析オフセット, 61
解析長, 60
外部モニタ, 5
外部利得／損失の補正, 50
拡張デスクトップ, 5
画面のプロパティ

変更, 8
環境仕様, 3

温度, 3
高度, 3
湿度, 3
冷却スペース, 3

き
機械仕様, 3
機器の返送, 11
機能, vi
競合

測定, 44

く
グラフィック・ドライバ, 8
クリーニング手順, 11

け
検索, 46

こ
コネクタ

RF 信号入力, 29
フロント・パネル, 17
リア・パネル, 18

コントロール
インタフェース, 18
表示固有, 21
フロント・パネル, 13

さ
再梱包, 11
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し
周波数マスク

Mask Editor, 40
トリガ, 38, 68

仕様
温度, 3
環境, 3
機械的特性, 3
高度, 3
湿度, 3
製品の寸法, 3
電源, 3
入力要件, 29
冷却スペース, 3

情報メッセージ, 26
診断, 10

す
スクリーン、印刷, 34
スタンダード・アクセサリ, 1

電源コード, 1
マニュアル, 1

スペクトラム長, 60
スペクトラム・アナライザ

リアルタイムの概念, 23
スペクトログラム表示, 70

せ
製品機能, vi
設置, 1

ネットワーク接続, 4
設定

デフォルト, 28
プリセット, 29
変更, 27

セットアップ
保存, 35
呼び出し, 36

選択されたウィンドウ, 42

そ
測定

競合, 44
ソフトウェアのアップグレード, vii

インストール, 11

た
タッチスクリーン･アクション・メ

ニュー, 33

ち
チェック・マーク・インジケー

タ, 20, 42

て
デフォルト設定, 28
電源, 3
電源コード・オプション, 1
電力レベル・トリガ, 38
データ

保存, 35
呼び出し, 36

データの保存, 35
データの呼び出し, 36

と
トランゼント信号, 63
トリガ

違反, 42
周波数マスク, 38, 68
電力レベル, 38
トリガ, 37
パラメータ, 38
フリーラン, 37
マスク, 40

トリガ・イベント・パラメータ, 38
アクセス, 38

トリガ・モード, 37

に
入力要件

RF 信号の範囲, 29
周波数レンジ, 29
電圧, 29
電源, 29
入力インピーダンス, 29

ね
ネットワーク接続, 4

は
パルス測定, 73
パルス統計表示, 77
パルス・トレース表示, 75

ひ
表示

Constellation, 59
DPX スペクトラム, 64
General Signal Vewing, 25
GP Digital Modulation, 25
RF 測定, 25
Signal Quality, 59
Time Overview, 60
印刷, 34
競合, 44
スペクトログラム, 70
選択, 26
パルス RF, 25
パルス統計, 77
パルス・トレース, 75

表示設定
変更, 27

表示の選択, 26

ふ
ファイルの種類, 36
部品番号、マニュアル, 1
フロント・パネル

コネクタ, 17
コントロール, 13

へ
変調解析, 57

ほ
保守

クリーニング手順, 11
再梱包, 11

補正テーブル, 50
保存オプション, 36

ま
マニュアル, vii

当社部品番号, 1
マーカ, 31

形状, 31
絶対, 31
追加, 32
定義, 33
デルタ, 31
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め
メッセージ

スクリーン上, 26

り
リアルタイム・スペクトラム・アナ

ライザ, 23
リア・パネル・コネクタ, 18

れ
冷却スペース, 3
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